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Welcome to BCM50 3.0, the unified communications solution that gives you an edge on your 
competition.

The BCM50 3.0 documentation is on the BCM50 3.0 Documentation CD-ROM. This CD-
ROM is in your BCM50 3.0 kit.

To view the documentation:

1 Insert the BCM50 3.0 Documentation CD-ROM into the CD-ROM drive of your 
computer.

2 Double-click the My Computer icon.

3 Double-click the CD-ROM icon.

4 Double-click Start.pdf.

This document provides last-minute changes to the BCM50 3.0 documentation.

Updated BCM50 3.0 documents
Some BCM50 3.0 documents were recently updated with new information. You can obtain the 
following updated documents in the BCM50 3.0 documentation collection on Helmsman 
(www.nortel.com/helmsman):

• BCM50 Administration Guide (NN40020-600)

• BCM50a Integrated Router Configuration Guide—Advanced (N0115791)

• BCM50a Integrated Router Configuration Guide—Basic (N0115790)

• BCM50e Integrated Router Configuration Guide—Advanced (N0115789)

• BCM50e Integrated Router Configuration Guide—Basic (N0115788)

• CallPilot Manager Help (04.7.10)

• CallPilot Manager Set Up and Operation Guide (NN40090-300)

• CallPilot Reference Guide (NN40090-100)

• CallPilot 4.0 Unified Messaging Addendum (NN40090-107)

• CS 1000 Main Office Configuration Guide for SRG 50 (NN43001-307)

• Device Configuration Guide (NN40020-300)

• Installation Checklist and Quick Start Guide (NN40020-308)

• Installation and Maintenance Guide (NN40020-302) 

• Intelligent Contact Center Setup and Operation Guide (NN40040-301)

• Intelligent Contact Center Supervisor Guide (NN40040-102)

• IP Phone 1200 Series Installation (NN40050-302)

• IP Phone 1200 Series User Guide (NN40050-111)

• IP Softphone 2050 Installation Guide (NN40050-300)

• ipView Software Wallboard Setup and Operation Guide (NN40010-500)

• LAN CTE Configuration Guide (NN40010-601)

• Meet Me Conferencing User Guide (NN40020-104)

http://support.avaya.com/supportfaqs
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• Multimedia Contact Center Set Up and Operation Guide (NN40040-300)

• Networking Configuration Guide (NN40020-603)

• Personal Call Manager User Guide (NN40020-103)

• Reporting for Contact Center Setup and Operations Guide (NN40040-303)

• SRG50 Configuration Guide (NN40140-500)

• System Overview (NN40020-200)

• Telephone Features User Guide (NN40020-100)

• Unified Messaging Configuration Guide (NN40080-501)

BCM50 Administration Guide

Page 32, BCM50 Web page
The BCM50 has the following system requirements:

• Windows XP, Windows 2000 Pro, or Windows Vista Business, Windows Vista Ultimate, or Windows Vista 
Enterprise (32-bit or 64-bit versions of Windows Vista)

Page 32, BCM50 Web page
Internet Explorer 7.0 is the default browser for Windows Vista platforms. When you access the BCM Web page 
using Internet Explorer 7.0 on a Windows Vista platform, a security certificate error page appears. Click Continue 
to this web site to go to the BCM Web page with a secure connection. The Certificate Error continues to appear in 
the Security Report next to the address bar.

Page 37, Installing Element Manager on a Windows operating system
BCM applications for BCM50 support the following Vista versions: Windows Vista Business, Windows Vista 
Ultimate, and Windows Vista Enterprise. Both 32-bit and 64-bit versions of Windows Vista are supported.

Page 190, About BCM monitor
The following operating systems support BCM monitor:

• Windows Vista Business, Windows Vista Ultimate, and Windows Vista Enterprise (both 32-bit and 64-bit 
versions of Windows Vista)

Page 285, List of BCM50 Alarms
Table 1 lists the new alarms introduced in BCM50 Release 3.0. These alarms are in addition to the alarms listed in 
the BCM50 Administration Guide (NN40020-600) for Release 3.0. The table includes the default handling of each 
alarm with respect to the Alarms table, the alarm set, LEDs, and SNMP traps.

You can customize whether each alarm appears in the Alarms table or is sent as an SNMP trap in accordance with 
your business requirements.
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Table 1   List of new alarms

Alarm 
ID Severity

Component 
Name

Problem 
Description

Problem 
Resolution Alarm SNMP LED

Alarm 
Set

10008 critical Service 
Manager

Service Manager - 
Voice Application 
Interface Service 
(ctiserver) has 
stopped 
unexpectedly. This 
will affect CallPilot, 
System Set Based 
Admin and IVR. 
Service Manager 
is attempting to 
restart the service.

Check for 
corresponding 
alarm 10108 or 
10308. If service 
doesn't restart then 
reboot system and 
contact your local 
support group.

Yes Yes Yes N/A

10916 Information Startup 
Sequence

System Startup - 
Operating system 
and alarm 
subsystem 
available. 
Separate error 
alarm detected. 
Power LED = 
flashing green; 
Status LED = 
unchanged.

No Action 
Required.

Yes No No No

10917 Information Startup 
Sequence

System Startup - 
Telephony and 
Voicemail active. 
Separate error 
alarm detected. 
Power LED = 
flashing green; 
Status LED = 
unchanged.

No Action 
Required.

Yes No No No

10918 Information Startup 
Sequence

System Startup - 
Element Manager 
is available. 
Separate error 
alarm detected. 
Power LED = solid 
green; Status LED 
= unchanged.

No Action 
Required.

Yes No No No

10919 Information Startup 
Sequence

System Startup - 
Startup complete. 
Service Manager 
and Scheduling 
Services available. 
Separate error 
alarm detected. 
Power LED = solid 
green; Status LED 
= unchanged.

No Action 
Required.

Yes No No No

18003 Major BootLoader Flash size is less 
than expected

Contact your local 
support group

Yes Yes Yes Yes

18004 Critical BootLoader System 
initialization failed

Contact your local 
support group

Yes Yes Yes Yes

18005 Minor BootLoader Network 
initialization failed

Contact your local 
support group

Yes No No Yes

18006 Minor BootLoader Ethernet MAC 
addresses not 
found

Contact your local 
support group

Yes No No Yes
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BCM50a Integrated Router Configuration Guide—Advanced, BCM50a Integrated 
Router Configuration Guide—Basic, BCM50e Integrated Router Configuration 
Guide—Advanced, BCM50e Integrated Router Configuration Guide—Basic

Preface chapter
BCM applications for BCM50 support the following Vista versions: Windows Vista Business, Windows Vista 
Ultimate, and Windows Vista Enterprise. Both 32-bit and 64-bit versions of Windows Vista are supported.

CallPilot Manager Help

Add Many Agents
Changed "the agent ID numbers you enter must be between 1 and 250," to "the agent ID numbers you enter must be 
between 1 and 100."

CallPilot Reference Guide, CallPilot Manager Set Up and Operation Guide, Intelli-
gent Contact Center Setup and Operation Guide, and Intelligent Contact Center 
Supervisor Guide

Silent Record a Call section
BCM50 release 3.0 does not support secure file transfer protocol (SFTP) as element manager (EM) screens in 
Silent Record a Call (SRC) and Backup Restore Utility (BRU) indicate. Instead, the secure copy protocol (SCP) is 
supported. Therefore, wherever an SFTP server is required, a server supporting SCP should be setup instead. 
Additionally, all instances of the phrase "SFTP" in the EM should be taken to mean "SCP."

CallPilot 4.0 Unified Messaging Addendum

Page 10, What you need
BCM supports Vista operating system versions: Windows Vista Business, Windows Vista Ultimate, and Windows 
Vista Enterprise. Both 32-bit and 64-bit versions of Windows Vista are supported.

CS 1000 Main Office Configuration Guide for SRG 50

Page 35, <SIP Trunks>

18007 Critical BootLoader Hard drive 
initialization failed

Contact your local 
support group

Yes Yes Yes Yes

31250 Warning Software 
Updates

The R3 factory 
image upgrade 
patch has not been 
installed. 
Performing a level 
2 reset will 
downgrade the 
system to a non 
R3 software level.

Apply the R3 
factory image 
upgrade patch

Yes Yes No No

Table 1   List of new alarms

Alarm 
ID Severity

Component 
Name

Problem 
Description

Problem 
Resolution Alarm SNMP LED

Alarm 
Set
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In order for the SRG 50 to act as a SIP endpoint and to use the SIP Trunks for call signaling with the CS 1000, you 
must configure SIP Trunks between the SRG 50 branch office and the CS 1000 Release 5.0 main office. For 
information about configuring SIP Trunks for SRG 50, see SRG 50 Configuration (NN40140-500). The following 
procedure refers to SIP Trunk configuration for the CS 1000 Release 5.0 main office.

Configuring SIP Trunks at the main office

1. From the Element Manager navigator, click IP Network > Nodes: Servers, Media Cards.
The Node Configuration window appears.

2. Click the Edit button associated with the node to be updated. 

3. Click the plus (+) sign beside Signaling Server Properties.

4. From the Enable IP Peer Gateway (Virtual Trunks TPS) list, select SIP only. 

5. Enter the CS 1000 domain name in the SIP Domain Name field.

6. Enter the SIP Port number in the Local SIP TCP UDP Port to Listen to field.

7. Enter the Signaling Server name in the SIP Gateway Endpoint Name field.

8. Click Save and Transfer. 

The Save and Transfer window appears.

9. Click OK.

10. Log on to Network Routing Service (NRS) Manager.

The Signaling Server is configured as
SIP only endpoint.

SIP Port

Endpoint name is configured as the 
Signaling Server name.

CS 1000 main office domain name
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11. Select the Configuration tab.

12. From the H.323 Support list, select H.323 not supported.

13. Select the Network Connection Server enabled check box.

14. Select Save.

15. Select Configuration > Gateway Endpoints. 

The Gateways Endpoints window appears.

The SRG registers as a static SIP endpoint.

Device Configuration Guide

Page 60, missing section after ATA Settings section
This section appeared in the TA version and was accidentally removed in the CA version.

IP Terminal Details tab
This is a single-terminal display of the terminal information that is also shown in the Telephony Resources IP 
Terminal panel. 

The SRG is treated as a pure SIP endpoint. 

Network Connection Server is enabled.

SRG registers as a static SIP endpoint.
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At start-up, the BCM acquires and retains a list of all IP terminals that have a registered DN. This allows DN-
specific features, such as Call Forward, Hotdesking, and voicemail to continue to function even if the telephone is 
disconnected. 

If the number of IP Set DNs registered with the BCM exceeds the number of IP Client key codes applied, selecting 
this check box prioritizes a set. 

For example, if the BCM is rebooted, and the number of IP phones exceeds the number of IP client key codes, the 
BCM retains the DN record of the sets with this field selected, before retaining the DN record of a set that does not 
have this field selected. 

If Keep DN alive is not selected, and the IP telephone is disconnected, the DN record may become inactive if there 
are not enough keycodes. In this case, a Not in Service prompt is produced when special features, such as Call 
Forward, are invoked.

Figure 1   IP Terminal Details tab

For more information about moving IP telephones, see Telephony Device Installation Guide (NN40020-309).

Installation Checklist and Quick Start Guide

Page 10, Tools and system information, Table 4
Description:

• Windows Vista Business, Windows Vista Ultimate, and Windows Vista Enterprise (32-bit and 64-bit versions) 

Page 16, Nortel Business Element Manager
BCM applications for BCM50 support the following Vista versions: Windows Vista Business, Windows Vista 
Ultimate, and Windows Vista Enterprise. Both 32-bit and 64-bit versions of Windows Vista are supported.

Installation and Maintenance Guide

Page 134, Prerequisites
BCM applications for BCM50 support the following Vista versions: Windows Vista Business, Windows Vista 
Ultimate, and Windows Vista Enterprise. Both 32-bit and 64-bit versions of Windows Vista are supported.

Installation and Maintenance Guide and Installation Checklist and Quick Start 
Guide

Page 3, SOFTWARE LICENSE

The following information is appended to the software license and copyright information.

Open source copyright (ppp-2.4) 

This product contains software that is distributed under open source agreements. 
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This product contains ppp-2.4, a package which implements the Point-to-Point Protocol (PPP) to provide Internet 
connections over serial lines. This open source package is freely downloadable at: ftp://ftp.samba.org/pub/ppp/.

The following copyright notices apply to this software:

Copyright (C) 2002 Roaring Penguin Software Inc.

Permission to use, copy, modify, and distribute this software for any purpose and without fee is hereby granted, 
provided that this copyright and permission notice appear on all copies and supporting documentation, the name of 
Roaring Penguin Software Inc. not be used in advertising or publicity pertaining to distribution of the program 
without specific prior permission, and notice be given in supporting documentation that copying and distribution is 
by permission of Roaring Penguin Software Inc..

Roaring Penguin Software Inc. makes no representations about the suitability of this software for any purpose. It is 
provided "as is" without express or implied warranty.

Copyright (C) 1995,1996,1997,1998 Lars Fenneberg <lf@elemental.net>

Permission to use, copy, modify, and distribute this software for any purpose and without fee is hereby granted, 
provided that this copyright and permission notice appear on all copies and supporting documentation, the name of 
Lars Fenneberg not be used in advertising or publicity pertaining to distribution of the program without specific 
prior permission, and notice be given in supporting documentation that copying and distribution is by permission 
of Lars Fenneberg.

Lars Fenneberg makes no representations about the suitability of this software for any purpose. It is provided "as 
is" without express or implied warranty.

Copyright 1992 Livingston Enterprises, Inc. 
Livingston Enterprises, Inc. 6920 Koll Center Parkway Pleasanton, CA 94566

Permission to use, copy, modify, and distribute this software for any purpose and without fee is hereby granted, 
provided that this copyright and permission notice appear on all copies and supporting documentation, the name of 
Livingston Enterprises, Inc. not be used in advertising or publicity pertaining to distribution of the program without 
specific prior permission, and notice be given in supporting documentation that copying and distribution is by 
permission of Livingston Enterprises, Inc.

Livingston Enterprises, Inc. makes no representations about the suitability of this software for any purpose. It is 
provided "as is" without express or implied warranty.

[C] The Regents of the University of Michigan and Merit Network, Inc. 1992, 1993, 1994, 1995 All Rights 
Reserved

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without 
fee is hereby granted, provided that the above copyright notice and this permission notice appear in all copies of the 
software and derivative works or modified versions thereof, and that both the copyright notice and this permission 
and disclaimer notice appear in supporting documentation.

THIS SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR 
IMPLIED, INCLUDING WITHOUT LIMITATION WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE. THE REGENTS OF THE UNIVERSITY OF MICHIGAN AND MERIT 
NETWORK, INC. DO NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL 
MEET LICENSEE'S REQUIREMENTS OR THAT OPERATION WILL BE UNINTERRUPTED OR ERROR 
FREE. The Regents of the University of Michigan and Merit Network, Inc. shall not be liable for any special, 
indirect, incidental or consequential damages with respect to any claim by Licensee or any third party arising from 
use of the software.
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Intelligent Contact Center Setup and Operation Guide

Page 44, Adding more than one agent
In Step 6, changed "the agent ID numbers you enter must be between 1 and 250" to "the agent ID numbers you 
enter must be between 1 and 100."

IP Phone 1200 Series installation

Page 38, Registering the IP Phone (global registration with password)
Step 5 in the procedure is changed as follows:

Press Select.

If EAP Enable appears on the screen, you successfully accessed the configuration mode.

If any other message appears, disconnect, then reconnect the power, and try to access the configuration mode 
again.

Page 42, Changing the display settings
Step 4 in the original procedure is deleted, and the renumbered step 5 (previously step 6) is modified as follows:

1 Double-press  (Services) quickly to open the Local Tools menu.

2 Press 1 on the dial pad to open the Preferences menu.

3 Press 1 on the dial pad to open the Display Settings menu.

4 Press Select.
5 Press the Left/Right navigation keys to increase or decrease the value.

6 Press Select.

End

IP Phone 1200 Series User Guide

Page 19, IP Phone 1210, 1220, and 1230 keys and descriptions
In table 3, the row describing the Hold key is changed as follows.

Table 3    IP Phone 1210, 1220, and 1230 keys and components descriptions 

Page 28, Call answer
The following section is modified as shown.

Answering a call
1 When you have an incoming call, perform one of the following:

• Lift the handset.
• Press the line or intercom key with the flashing S indicator, and then lift the handset.

Key or component Description

Hold key Press the Hold key to put an active call on hold. Tap the flashing line 
(DN) soft key to return to the caller on hold.
You can also press the Hold key to retrieve a call when certain features 
are active such as the Do Not Disturb feature.
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When certain features are active such as the Do Not Disturb feature, you must press the Hold key to answer an 
incoming call.

IP Softphone 2050 Installation Guide

Page 15, Minimum PC Requirements
• 800 MHz processor (for Windows Vista Business, Windows Vista Ultimate, and Windows Vista Enterprise 

[32-bit versions only of Windows Vista])

• 512 MB memory (for Windows Vista Business, Windows Vista Ultimate, and Windows Vista Enterprise [32-
bit versions only of Windows Vista])

• 20 GB hard drive (for Windows Vista Business, Windows Vista Ultimate, and Windows Vista Enterprise [32-
bit versions only of Windows Vista])

• 15 GB of available hard drive (for Windows Vista Business, Windows Vista Ultimate, and Windows Vista 
Enterprise [32-bit versions only of Windows Vista])

• support for super VGA graphics (for Windows Vista Business, Windows Vista Ultimate, and Windows Vista 
Enterprise [32-bit versions only of Windows Vista])

Page 15, Supported Operating Systems
• Windows Vista Business, Windows Vista Ultimate, and Windows Vista Enterprise [32-bit versions only of 

Windows Vista])

Page 16, USB Audio Kit
It is functional on Windows 2000 Professional, Windows 98, Windows 98 Second Edition, Windows Millennium, 
Windows XP, Windows Vista Business, Windows Vista Ultimate, and Windows Vista Enterprise (32-bit versions 
only of Windows Vista).

Page 16, Specifications
• OS compatibility: Windows 2000, Windows ME, Windows XP, Windows Vista Business, Windows Vista 

Ultimate, and Windows Vista Enterprise [32-bit versions only of Windows Vista])

ipView Software Wallboard Setup and Operation Guide

Page 10, Operating system compatibility
BCM applications for BCM50 support the following Vista versions: Windows Vista Business and Windows Vista 
Ultimate (only 32-bit versions of Windows Vista are supported).

LAN CTE Configuration Guide

Page 9, Operating system requirements
LAN CTE supports client computers with these operating systems:

• Windows 2000

• Windows XP

•  Windows Vista Business, Windows Vista Ultimate, or Windows Vista Enterprise (32-bit or 64-bit versions of 
Windows Vista)
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Meet Me Conferencing User Guide
Page 9, Conference phases

Page 20, To configure a passcode using softkeys
The following sentence is added at the end of step 3 and the PASS softkey is removed from the display:

"The passcode no longer appears as an option."

Page 27, To mute a single participant using softkeys
The following note is added at the end of step 3:

"NOTE: UNDO is available for 15 seconds after pressing MUTE. After 15 seconds, the softkey is blank and the 
participant must unmute their line."

Page 31 and 33, To hear a list of available commands using softkeys
Remove step 4: "After list of available commands, returns to main menu."

Page 36, To set a passcode using your keypad
Remove step 2.: You longer need to press 1.

Multimedia Contact Center Set Up and Operation Guide

Page 21, Computer requirements
The computer you use to run CallPilot Manager must have

• Windows 2000 Professional SP4, Windows XP Professional SP2, Windows Vista Business, Windows Vista 
Ultimate, or Windows Vista Enterprise (32-bit or 64-bit versions of Windows Vista).

Networking Configuration Guide

Page 115, Table 21, Routing Table fields
Changed Name field to Description to match changes in Element Manager. 

Also, same table, changed MCDN Protocol description:

Note: When you enable the QuickStart feature on a Meet Me Conferencing bridge 
that extermal conference participants can access by using a 1-800 number, there is 
a risk that your company can incur unauthorized toll charges. To avoid this type of 
fraud, do not enable the QuickStart feature on a conference bridge that can be 
accessed with a 1-800 number.

Description <alphanumeric> Enter the name of the remote system. This must be a 
unique name within the routing table.

MCDN Protocol <drop down list>
None, SL1, CSE
Default: None

For non-Nortel endpoints, select None. 
For BCM50 2.5 and IPT 3.0, select SL1.
For CS1K, BCM50 3.0, and newer, select CSE.
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Page 119, H323 Settings
New screen shot of H323 Settings showing Gateway protocol changed to MCDN protocol.

Page 120, Table 23, H323 Settings fields
Gateway protocol changed to MCDN protocol.

Page 120, Table 23, H323 Settings fields
The Modify field description was moved to the top of the Configuration section and the description field was 
updated.

Also, the Gatekeeper TTL field was described as Read-only.

MCDN protocol None
SL1
CSE

These protocols require a keycode.
SL1: Use this protocol only for BCM50 2.5 systems
CSE: Use this protocol for BCM50 3.0 and later systems. 
This protocol supports Meridian 1 IPT.
Otherwise, use None.

Configuration

Modify <button> Click to modify the parameters.
Note: If you change any field in the Configuration section, all 
active H.323 calls are dropped. You must click Modify to 
restart the H.323 subsystem.

Gatekeeper TTL (s) Read-only. The actual time used by the gatekeeper for the registration 
process.
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Page 122, Table 24, H323 Media Parameters record
’None’ was removed from the list of possible values for Preferred Codecs.

Page 126, Table 26, SIP Proxy fields
The description of the Domain field was updated.

Page 128, Table 27, Outbound Proxy table
The description of the Keep Alive field was updated.

Page 131, SIP URI map
There are three new paragraphs added to the first section:

These fields correspond to Public Network, Private Network, and Routing settings of the Configuration > 
Telephony > Dialing Plan section of Element Manager. 

On the Public Network screen, a Public network dialing plan setting of:

• Public (Unknown): corresponds to the SIP URI map of Unknown/Unknown.

• Local (Subscriber): corresponds to the SIP URI map of e.164/Subscriber.

• National: corresponds to the SIP URI map of e.164/National.

On the Routing screen, a DN type setting of:

• Public (Unknown): corresponds to the SIP URI map of Unknown/Unknown.

• International: does not correspond to the SIP URI map. A ‘+’ is prepended to the number.

• National: corresponds to the SIP URI map of e.164/National.

• Special (International): corresponds to the SIP URI map of Private/Special.

Preferred Codecs G.711-uLaw
G.711-aLaw
G.729
G.723

Select the Codecs in the order in which you want the system to 
attempt to use them.
Performance note: Codecs on all networked BCM50s must be 
consistent to ensure that interacting features such as Transfer 
and Conference work correctly.
Systems running BCM50 3.5 or later software allow codec 
negotiation and renegotiation to accommodate inconsistencies in 
Codec settings over VoIP trunks.
Note: The G.723 codec can be used between IP endpoints. If 
other types of connections are required, ensure one of the other 
codecs is also selected.

Domain <alphanumeric> This attribute is mandatory.
This is the SIP domain handled by the proxy. If it is also a DNS 
resolvable hostname of the proxy, a DNS lookup is done to 
route the messages. 
Otherwise, an IP address should be provided in either the 
legacy routing box or in the Outbound Proxy table.

Keep alive None
OPTIONS
Default: None

This attribute helps the system determine 
if an Outbound proxy device is responding.
If you select None, the system assumes 
the device is active and does not ping the 
device.
If you select OPTIONS, the system sends 
a periodic OPTIONS message to the 
Outbound Proxy. If the proxy fails to 
respond, the system bypasses the proxy.
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• Local (Subscriber): corresponds to the SIP URI map of e.164/Subscriber.

• Private: corresponds to the SIP URI map of Private/CDP, Private/UDP, or Private/Subscriber depending on the 
Private network type choice on the Private Network screen.

Page 132, Figure 38, SIP URI map tab
This is a new screen shot reflecting the new field, Private/Subscriber.

Page 132, Table 29, SIP URI map fields
There is a new entry in the table reflecting the new field, Private/Subscriber.

Page 274, Second Dial Tone
This is a Change Request fix. The following Note is added at the end of this section.

Attribute Value Description

SIP Domain Names

e.164 / National national.e164 String to use in phone context to identify numbering plan type

e.164 / Subscriber subscriber.e164 String to use in phone context to identify numbering plan type

e.164 / Special special.e164 String to use in phone context to identify numbering plan type

e.164 / Unknown unknown.e164 String to use in phone context to identify numbering plan type

Private / UDP UDP String to use in phone context to identify numbering plan type

Private / CDP CDP String to use in phone context to identify numbering plan type

Private / Special special.private String to use in phone context to identify numbering plan type

Private / Unknown unknown.private String to use in phone context to identify numbering plan type

Private / Subscriber subscriber.private String to use in phone context to identify numbering plan type

Unknown / Unknown unknown String to use in phone context to identify numbering plan type

Note: A second dial tone is not provided if an SDT prefix is entered 
as an External Autodial (Feature *1).
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Page 428, Table 86, Meet-Me Conferencing fields

Page 546, Table 24 ISDN Dial-in Parameters fields
This is a fix for CR Q01495226. This is an updated description of Dial-in number.

Personal Call Manager User Guide

Page 17, Before you start
Personal Call Manager is not supported on the 64-bit version of Windows Vista Business, Windows Vista 
Ultimate, or Windows Vista Enterprise operating systems.

Reporting for Contact Center Setup and Operations Guide

Page 20, Operating System Compatibility

SRG50 Configuration Guide

Page 15, SRG50 overview
The following sentence is added to this section:

"BCM50 supports up to 80 survivable IP users with a single SRG application authorization code."

Note: When you enable the QuickStart feature on a Meet Me Conference bridge 
that extermal conference participants can access by using a 1-800 number, there is 
a risk that your company can incur unauthorized toll charges. To avoid this type of 
fraud, do not enable the QuickStart feature on a conference bridge that can be 
accessed with a 1-800 number.

Dial-in Number <numeric 
string>

This field is reserved for future use. The Dial-in number is not required.

Operating System Version

Windows 2000 5.00.2195, SP4

Windows XP Professional, Version 2002, SP2

Windows Server 2003 Standard Edition, SP1

Windows Vista Business and Ultimate Editions (32-bit 
versions only are supported)
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Page 15, SRG Overview
The following sentence and table are added to this section:

"For a summary of differences between SRG versions, see the following table." 

Table 1   Summary of supported features on the different SRG versions

Features SRG 1.5 on BCM 200/400 SRG50 1.0 SRG50 2.0 SRG50 3.0

Platform Available on BCM 200/400 
hardware.
SRG 1.5 is not available on 
BCM1000 hardware.

Available on standard 
BCM50 hardware.
SRG50 1.0 is not available 
on BCM50a or BCM50e 
hardware. 

Available on standard 
BCM50 and BCM50b 
hardware only. 
SRG50 2.0 is not available 
on BCM50a, BCM50ba, 
BCM50e, and BCM50be 
hardware.

Available on standard 
BCM50 and BCM50b 
hardware only. 
SRG50 3.0 is not available 
on BCM50a, BCM50ba, 
BCM50e, and BCM50be 
hardware.

Call Servers CS1000 Release 3.0, 4.0, 
and 4.5.

CS1000 Release 3.0, 4.0, 
and 4.5.

CS1000 Release 4.0, 4.5, 
and 5.0.

CS1000 Release 4.0,4.5, 
and 5.0.

Trunking H323 is supported. H323 is supported. When CS1000 is 
supported by SRG, both 
H323 and SIP trunks are 
supported between them. 

H323 and SIP trunking are 
supported.

IP clients IP Phones 2001, 2002 
(phase 1 and 2), 2004 
(phase 1 and 2), 2007.
IP KEM, IP Phone 2050 
series. 
IP Phone 1110, 1120, 
1140, IP Phone 2033 
(polycom), WLAN 2210/
2211/2212.

IP Phones 2001, 2002 
(phase 1 and 2), 2004 
(phase 1 and 2), 2007.
IP KEM, IP Phone 2050 
(v1). 
IP Phone 2033 (polycom), 
2122.

IP Phones 2001, 2002 
(phase 1 and 2), 2004 
(phase 1 and 2), 2007.
IP KEM, IP Phone 2050 
series. 
IP Phone 1120, 1140, 
IP Phone 2033 (polycom), 
WLAN 2210/2211/2212.

IP Phones 2001, 2002 
(phase 1 and 2), 2004 
(phase 1 and 2), 2007.
IP KEM, IP Phone 2050 
series. 
IP Phone 1110, 1120, 
1140, IP Phone 2033 
(polycom), WLAN 2210/
2211/2212.

Number of IP 
clients supported

90 32 80 80

NetIQ Not supported Not supported Supported Supported

PVQM Not supported Not applicable Supported Supported

ESA Supported Supported Supported Supported. 
On Site Notification (OSN) 
of E911 alarms supported 
for local users through a 
third party tool.

Vo911 Supported Supported Supported Supported

Enhanced 
firmware 
download

Supported Supported Supported Supported 

Analog station 
support

The number supported 
depends on the hardware.
For BCM200, two analog 
station modules are 
supported. 
Number of analog nodes= 
2*8 =16.
For BCM400, four analog 
station modules are 
supported.
Number of analog nodes= 
4*8 =32).

Two analog station 
modules are supported.
Number of analog nodes= 
2*8 =16).

Two analog station 
modules are supported.
Number of analog nodes= 
2*8 =16).

Two analog station 
modules are supported.
Number of analog nodes= 
2*8 =16).
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Page 17, To increase the number of survivable IP users
The following information is removed from this section: 

"Upon SRG activation, the maximum number of 80 IP users is available. Therefore, there is no need to increase 
that number."

Page 23, Local mode
The following note is added to this section: 

Page 29, VoIP trunk configuration
The following step is inserted before the previous step 1:

1 Configure routing table:

Configuration > Resources > Telephony Resources > Modules panel > IP Trunks row > Routing Table.

External Reference: Networking Configuration Guide (NN40020-603).

Page 30, VoIP trunk configuration
The following step is added after step 3, and step 3 is modified:

3 Configure H323 settings:

Configuration > Resources > Telephony Resources > Modules panel > IP Trunks row > H323 Settings 
tab

Internal Reference: Gatekeeper routing on page 73.
External Reference: Networking Configuration Guide (NN40020-603).

4 Configure SIP settings:

Configuration > Resources > Telephony Resources > Modules panel > IP Trunks row > SIP Settings 
tab

Internal Reference: Gatekeeper routing on page 73.
External Reference: Networking Configuration Guide (NN40020-603).

Page 38, Virtual trunk capacity
The following sentence is added to this section: 

"SRG50 supports 24 virtual IP trunks that are either H.323 only, SIP only, or a combination of the H.323 and SIP." 

Note: The IP Phone KEM is supported on an SRG with normal mode 
IP Phones. It does not function with local mode or test local mode 
IP Phones.
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Page 44, S1000 Main Office Settings panel
In Table 7, the description for the H.323 ID field is updated as shown below. 

Page 51, Supported firmware
In Table 11, the column for CS 1000 Release 5.0 is updated as shown. 

Page 72, VoIP trunking configuration
The following information is added to this section:

SIP configuration
"Access the IP Trunks configuration panel in Element Manager to configure the SIP trunks (Configuration > 

Table 7    S1000 Main Office Settings

Field Values Description

H323 ID SRG* (default)
*This setting must be changed.

For naming conventions, see the 
Networking Configuration Guide 
(NN40020-603).

Gatekeeper setting that identifies the SRG.

This value must match the value in the Alias names 
field of the Local IP gateway:
Configuration > Resources > Telephony 
Resources > Modules panel > Module type 
column: select IP Trunks > Details for Module: 
Internal details panel > Local Gateway tab > 
Gatekeeper Support subpanel > Alias names field 
(see VoIP trunking configuration on page 72).
The SRG acts as a SIP endpoint and obtains the 
Main Office TPS IP address from the NCS using 
the H323 ID. 
Configure this field as the same SIP endpoint name 
as you configure for the NRS endpoint name. This 
is a generic field used for both SIP and H.323 
virtual trunk configurations.

Table 11 Supported IP clients and firmware versions

IP Client BCM50 CS 1000

Release 4.0 Release 4.5 Release 5.0

Phase I: 2002, 2004 B65 or greater B65 or greater B76 or greater B76 or greater

Phase II: 2001, 2002, 
2004

D98 or greater D88 or greater 0604DBG or 
0604DAS

0604DBG

IP Phone 2007 C22 or greater C22 or greater 0621C4J or 0621C3J 0621C4J

WLAN Handsets 2210/
2211

Not embedded in 
SRG software

Use the 2210/2211 
GA firmware load.

97.059 or greater 97.059 or greater

WLAN Handset 2212 Not embedded in 
SRG software

97.039 or greater 97.059 or greater 97.059 or greater

IP Phone 2033 Not embedded in 
SRG software

S12 or greater S12 or greater S12 or greater

IP Phone 1110 0623C38 0624C1E 0623C4B or 
0623C3C

0623C4D

IP Phone 1120E 0624C1B 0624C1E 0624C4B or 
0624C3C

0624C4D

IP Phone 1140E 0625C1B 0625C1E 0625C4B or 
0625C3C

0625C4D

IP Softphone 2050 build 385 or greater build 385 or greater build 385 or greater 2.1.355 or greater

MVC 2050 build 126 or greater build 126 or greater build 126 or greater 2.1.202 or greater
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Resources > Telephony Resources > Modules panel > Module type column > IP Trunks, then select the SIP 
Settings tab)."

"When you set the value of the RFC2833 Dynamic Payload field, if the value is greater than 0, then this feature is 
enabled. If the feature is enabled then DTMF digits are sent in RTP packets. For CS1000 Release 4.5 set the value 
to 0."

"For detailed information on entering the values in this panel, see the Networking Configuration Guide (NN40020-
603)."

Page 91, Appendix A: Telephone features in normal and local mode
The bullet “IP Phone Key Expansion Module (KEM)” is changed to:

• "IP Phone Key Expansion Module (KEM) – The IP Phone KEM is supported on an SRG with normal mode 
IP Phones. It does not function with local mode or test local mode IP Phones."

System Overview

Page 27, Windows Vista operating system
BCM applications for BCM50 support the following Vista versions: Windows Vista Business, Windows Vista 
Ultimate, and Windows Vista Enterprise. BCM applications support both 32-bit and 64-bit versions of Windows 
Vista, except for the following limitations:

• The CTE TAPI option is not supported by the 64-bit version of Windows Vista (x64).

• Personal Call Manager is not supported by the 64-bit version of Windows Vista (x64).

• Reporting for Contact Center is not supported by the 64-bit version of Windows Vista operating systems.

• CallPilot Desktop Messaging 4.0 does not support Groupwise 7.x on Windows Vista operating systems.

• The IP SoftPhone 2050 is not supported by the 64-bit version of Windows Vista operating systems.

• VPN client is not supported by the 64-bit version of Windows Vista operating systems.

Page 27, Windows Vista operating system
The following sentences are removed from this section:

"Most applications that run on Windows XP also work on Windows Vista with no changes. Of the applications that 
do not run on Windows Vista, the majority can run with the help of either a Compatibility Layer (a setting that 
provides some Windows XP functions to the application) or an Elevation Layer (a setting that runs the application 
with administrator privileges)."

Page 27, Windows Vista operating system
The following table includes the following new rows: 

Page 28, Unified Messaging Client exceptions
CallPilot Desktop Messaging 4.0 does not support Groupwise 7.x on Vista. You can download Windows Help that 
is used by CallPilot help from the Microsoft Download Center. The Desktop Messaging installation can appear to 

BCM50 application Vista compatible

ipView Software Wallboard Setup and Operation Guide Yes

Reporting for Contact Center Yes

IP Softphone 2050 Yes (32-bit version only)

Personal Call Manager Yes (32-bit version only)

LAN CTE TAPI Service Provider Yes (32-bit version only) 

VPN Client Yes (32-bit version only)
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be stalled for several minutes when you are completing the installation process. 

Vista Windows Mail purge messages fails because of Microsoft limitations. To avoid this failure and keep deleted 
messages in your Inbox, navigate to Tools > Options > Advanced. Deselect the Use the Deleted Items Folders with 
IMAP accounts check box. To show deleted messages in your Inbox, navigate to View > Current View. Select the 
Deleted Messages check box.

Telephone Features User Guide
Page 8, Meet Me Conferencing Feature 930

Unified Messaging Configuration Guide

Page 8, Windows operating systems
• Windows Vista Business

• Windows Vista Ultimate

• Windows Vista Enterprise

Both 32-bit and 64-bit versions of Windows Vista are supported.

Page 8, Supported integrated clients
CallPilot Desktop Messaging 4.0 does not support Groupwise 7.x on Microsoft Vista operating systems.

Chapter 4, page 63, Troubleshooting
Vista Windows Mail purge messages fail due to Microsoft limitations

To keep and show deleted messages in your Inbox

1 From the menu bar, navigate to Tools > Options > Advanced.

2 Select the Use the Deleted Items Folder with IMAP accounts.

Deleted items remain in your Inbox.

3 While in your Inbox, navigate to View > Current View.

4 Select the Show Deleted Messages checkbox.

Deleted items are shown in your Inbox.

Note: When you enable the QuickStart feature on a Meet Me Conferencing bridge 
that extermal conference participants can access by using a 1-800 number, there is 
a risk that your company can incur unauthorized toll charges. To avoid this type of 
fraud, do not enable the QuickStart feature on a conference bridge that can be 
accessed with a 1-800 number.

1-800-4 NORTEL
www.nortel.com

September 2007 NN40020-400
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